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Tuesday 
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August 9, 2011 
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Meeting & Presentation Begins Between 7:00 & 7:15 PM 

NO MEETING 
 

See You in 
September 

L C C U G

What’s in Your Hard 
Drive? Here are the  
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A recurring theme for me is marveling at how pervasive com-

puters are in our lives today.  I am always amazed to think 

about how, not that long ago, we couldn‟t have imagined this 

scenario. 
 

A relative is in the process of moving in with his girlfriend 

whom he met online.  The house they are renting was found 

on craigslist.com.  Her new job was found online. 
 

The dog I adopted 6 months ago was found at a pet rescue 

website online.  The obedience school I took him to was 

found through an online search. A cage to use during his 

puppy training was found via craigslist.  Suggestions in deal-

ing with a new puppy were found by searching the Internet. 
 

Two years ago when I went to the emergency room I told 

them that I had Googled my symptoms and thought I had ap-

pendicitis.  They took out my appendix. 
 

When my brother‟s 10 year projection TV had the picture go 

goofy, he Googled a description of the exact problem.  There 

he found a discussion of the issue on that exact model TV and 

a fix.  He followed the suggestion and sent for a small part 

and instructions and he fixed his problem.  An obscure prob-

lem that would have been almost impossible to have had fixed 

locally. 
 

How many times have I gone to buy something that I have 

already read about exhaustively online. When I go to the store 

and talk to the salesperson, I already know the issues, cus-

tomer opinions, and the many variables.  I can quickly ask my 

questions about the product we are looking at and make an 

informed decision and make my purchase.   
 

How many times have I become aware of a great movie I 

want to see or a book I want to read because of an online arti-

cle or discussion!  I love hearing about these things this way. 
 

The night before a recent memorial service, I browsed 

through my computer‟s picture folders and found a dozen nice 

pictures of the deceased and uploaded them to the nearby 

Walgreen‟s website.  In the morning I stopped in and picked 

up an attractive 11 x 17” poster of the pictures to display at 

the memorial. 
 

My daughter‟s favorite way to have music playing when sit-

ting outside or while entertaining friends, is to go to Pan-

dora.com on the laptop and select a theme of music to play.  

Large external speakers enable the music to be played on the 

patio or house throughout the evening.   
 

Now to travel somewhere, you either have directions printed 

from Google maps, or you are being guided there by your 

GPS unit or the GPS on your smartphone.  These tools will 

also help you find restaurants, shopping and hotels as you go. 
 

Looking for a good casserole recipe?  Do you need a nice dip 

idea to take to a party?  Just do a search on the ingredients 

you would like to use and browse through the many choices 

that will be presented to you, complete with the comments of 

others who have tried the recipe.  This is much quicker than 

going through many paper cookbooks that might be on your 

shelf. 
 

What about email?  It is not without some problems as a 

means of communication, but can you imagine waiting for a 

letter to arrive?  Or trying to catch someone on the phone?  

Now there is chat and texting, ubiquitous cell phones, face-to-

face Skype……..Facebook?  Twitter?  And then, what‟s next? 
 

I could go on and on but it all comes down to, how did we 

used to do these things?  Even 10 years ago, would we have 

imagined?  And like I always start to wonder… what will 

things look like in another 10 years?  If technological change 

continues exponentially, I truly can‟t imagine!! 
 

It‟s always amazing to think about!! 
 

     Sandee 

mailto:president@lccug.com
mailto:vp-programs@lccug.com
mailto:secretary@lccug.com
mailto:treasurer@lccug.com
mailto:newsletter@lccug.com
mailto:webpage@lccug.com
mailto:statutory_agent@lccug.com
mailto:membership@lccug.com
mailto:advertising@lccug.com
mailto:public_relations@lccug.com
mailto:education@lccug.com
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TUESDAY 

Aug 9, 2011 

TUESDAY 

Aug 23, 2011 

 

No Meeting Tonight 

2nd Monthly Meetings are  
Cancelled for the Summer 

What’s in Your Hard Drive? 
 Here are the A,B,C’s  

 

by  
Neil Higgins 

  

Ever wonder exactly what is in that big box 
connected to your computer?  

 

Neil will take us on a "live tour" of our Hard 
Drive and identify parts and show us 
where and how we can safely and intelli-
gently add or replace parts. 
 
Neil has been working with and teaching 
computers for a very long time! Be sure 
and bring any questions you may have as 

we see what is in the "box" and why. You probably can 
not stump him on this subject! This promises to be a 
very interesting program. 
 

The program will be followed by a question and answer 
period. 

L C C U G

READ ALL ABOUT IT!!!! 
 

Our 2nd meeting of the month is cancelled for the Sum-
mer.  The board thought that a lot of our members 
would be going on vacation or just wanting to spend 
summer time with their family & friends, so only one 
meeting a month until Tuesday, September 13, 2011,  

 
Networking Your Computers  

Presented by 
Lloyd & Carl from Discount Computer Parts 

This and That or Things That May 

Interest You  
By Lynn Page, Editor, Crystal River Users Group, Florida 

February 2011 issue, CRUG newsletter   www.crug.com 

newsletter@crug.com 
 

Excel  

Copy with No Formatting  

To copy the contents of a cell and not the underlying formula 

on the Home tab, in the Clipboard group, click Copy. Move 

to the cell to paste into and on the Home tab, in the Clipboard 

group, click Paste, and then click Paste Values.  
 

Move or Copy a Formula  

Cell references are important and it is important to be aware 

of what can happen to these references, whether absolute or 

relative, when moving a formula by cutting and pasting it, or 

by copying and pasting the formula into a new location.   
 

When moving a formula, the cell references within the for-

mula do not change regardless of the type of cell reference 

used.  When copying a formula, the cell references may 

change based on the type of cell reference used. Verify that 

the cell references in the formula produced the desired result. 

If not, switch the type of reference.   
 

Windows 7  

Run Multiple Copies of Applications from the Taskbar  

Many times I like to have two Word documents open side by 

side. To open multiple copies of an application so that differ-

ent files are shown in separate windows, shift click the icon 

on the Task Bar to open an additional application window.  
 

Pin a Folder to the Windows Explorer Jump List  

To have a folder quickly available in Windows Explorer pin it 

to the Explorer Jump List. Find and select the folder, then 

drag and drop it to the Windows Explorer icon on the Task 

bar. To quickly open the folder right click the Windows Ex-

plorer icon and select the folder from the jump list.  
 

USB Security and Protection  

USB flash drives are wonderful for transporting files between 

computers. Just remember that if one computer is infected 

with a virus or malware, it can come along on the flash drive. 

So for security before transferring files, scan the flash drive 

with up to date virus and antimalware before copying files.  
 

There is no restriction against any non-profit group using this article as 
long as it is kept in context with proper credit given the author. The 
Editorial Committee of the Association of Personal Computer User 
Groups (APCUG), an international organization of which this group is 
a member, brings this article to you. 

http://www.crug.com
mailto:newsletter@crug.com
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Executive Board  

Meeting Minutes 
General 

Meeting Minutes 

JUNE 28, 2011 
 

Attending were Sandee Ruth, Don Hall, Micky 
Knickman, Pam Rihel, Richard Barnett Dennis Smith 
and Kaye Coller. 
 
A review of items needed for the picnic included big 
coolers (Sandee and Pam), corn hole game (Sandee 
and Pam), horse shoes (Micky).  
 
To register for the picnic on line, Richard will program a 
link on our web page.  
 
A printer will be raffled with the drawing taking place at 
the picnic. 
 
Sandee announced we are entered into the APCUG 
webpage/newsletter contest. 
 
Richard gave a summary of information he obtained  
from a free Google app. showing  the activity on our 
web page -  307 hits from 120 people from 6 countries 
looking at 1 1/2 pages for 1 minute  and 447 views. 
 
The board discussed topics for future presentations. 
 
Micky moved, Richard seconded the meeting be 
adjourned. 

JULY 12, 2011 
 

President Sandee Ruth called the meeting to order. A 
motion to accept the minutes as shown in the July issue 
of the INTERFACE was made by John Dunn, seconded 
by Jack Trifiletti. Motion passed. 
 
Sandee mentioned the upcoming annual picnic at 
French Creek Reservation and how to get there. Signup 
is necessary and there will be a link on the LCCUG web 
page. 
 
Sandee then presented an updated version of Cloud 
Computing which was presented last year. She showed 
the applications such as Docs, Calendar, Storage avail-
able by Google. She then showed some of her own ac-
counts. All of these apps and files are available to the 
user from their Phones, iPods, Netbooks or Tablets  
which have internet access. 
 
Ellen Endrizal won the money raffle which included 
drawing the Joker. Enio Fernandez won the first soft-
ware/hardware raffle. Micky Knickman missed the $5 
attendance drawing, but Richard Long won the $4 atten-
dance drawing. 
 
Joe Harrold moved, Don Hall seconded the meeting be 
adjourned. 

On Site or Walk In Services  

440-322-0259 
210 East Second St., Elyria 44035 

New Systems Upgrades 

Diagnostics Installations 

Virus Removal System Tune Ups 

Rebuilt Systems 

Newsletter Editor:  Pam Rihel using Microsoft Publisher, Corel 
Paint Shop Pro X3, CreataCard 8.  
 

This Month’s contributors: Micky Knickman, Sandra Ruth, Kaye 
Coller, Pam Rihel, Carole Doerr, Don Hall, Lynn Page, Lou Koch, 
Gregory Anderson, Wayne Comstock, Will Wakely, APCUG, 
Wordtips.net, Exceltips.net, Smart Computing Magazine, 
M ic r os o f t  O f f i c e  a r t  o n l i ne ,  W or ldS t ar t . com , 
computerworkers.png  simonwhatley.co.uk 
 

Newsletter is now 
Online 

at 
lccug.com/newsletters or lccug.com 

LCCUG Treasurer's Report 

6/24 Beginning balance  $ 10,232.62  

  membership dues  $       75.00  

7/20 LCCUG Certificate of Deposit  $   5,000.00  

7/20 General Fund balance  $   5,307.62  

http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com/
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://www.wordtips.net
http://www.exceltips.net
WorldStart.com
http://www.google.com/imgres?q=free+computer+cartoons&hl=en&sa=X&rlz=1T4ADRA_enUS398US398&biw=1280&bih=816&tbm=isch&prmd=ivns&tbnid=tPp_IqLNvkLWVM:&imgrefurl=http://www.simonwhatley.co.uk/cartoon-computer-workers-free-time&docid=o8BzVzp3OqnRSM&w=580&h=501&ei=
simonwhatley.co.uk
http://www.lccug.com/newsletters
http://www.lccug.com
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 Pam Rihel  LadyGeneo@roadrunner.com 

Problems Searching Through 
Old Records And The  

Problems You Will Encounter. 
 

If you ever looked at records that were created several 
decades ago, particularly before the turn of the century, 
you know that they aren‘t always easy to understand. 
 
Handwriting styles were different and people weren‘t 
always particular about spelling and punctuation.  You‘ll 
find that some words had different meanings, and when 
you go back a couple of centuries, even dates were 
different.  If you are planning to look at older records, 
first check out the calendar switch and double dates. 
Example:  
 
Julian or Old Style: 
December 25, 1718 
January 1, 1718 
February 2, 1718 
March 20, 1718 
March 25 1719 
 
Gregorian or New Style: 
December 25, 1718 
January 1, 1719 
February 2, 1719 
March 20, 1719 
March 25, 1719 
 
Double Date: 
December 25, 1718 
January 1, 1718/1719 
February 2, 1718/1719 
March 20, 1718/1719 
March 25, 1719 
 
Beginning in 45 B.C., many parts of the world used the 
Julian calendar to mark the passage of time.  By the 
Julian calendar, March 25, was the first day of the year 
and each year was 365 days and 6 hours long.  In 
1582, Pope Gregory XIII determined that the Julian 
calendar was incorrect: each day was just a little bit too 
long and the human calendar wasn‘t keeping up with 
nature‘s calendar.  This new calendar changed the first 
day of the year to January 1 and also jumped ahead by 

10 days to make up for the lost time.   
 
The practice of double dating resulted from the switch 
from the Julian to the Gregorian calendar.  Not all coun-
tries and people accepted this new calendar at the 
same time.  England and the American colonies didn‘t 
officially accept it until 1752.  Before that date, the gov-
ernment observed March 25, as the first of the year, but 
most of the population observed January 1 as the first of 
the year.  For this reason, many people wrote dates fal-
ling between January 1 and March 25 with both years, 
as in the examples in the beginning of this article. 
 
By the time England and the colonies adopted the new 
calendar, the discrepancy between the calendars was 
eleven days.  To resolve this discrepancy, the govern-
ment ordered that September 2, 1752 be followed by 
September 14, 1752.  some people also added 11 days 
to their birth dates that are recorded as double dates 
even after all calendars had officially switched.  People 
sometimes accidentally wrote double dates. 
 
Handwriting: 
―If only the typewriter had been invented a few centuries 
earlier!‖  That‘s often the cry of people trying to read 
older records.  Old fashioned handwriting often gives 
older documents charm, but it also can be difficult to 
decipher.  Below are a few clues that may help you out: 

First, read slowly and with care.  Make sure that the 

words make sense, and don‘t assume anything. 

Watch out for double S‘s.  The first S in a pair was 

often written to look like a lower case F. 

The following capital letters often look the same: I 

and J, L and S, L and T, M and N, T and F, and U 
and V. 

Don‘t forget the possibility of abbreviations.  Names 

were abbreviated quite often, as well as common 
words.  For example, you may find ―sd‖ for ―said‖, 
―decd‖ for ―deceased,‖ ―do‖ for ―ditto,‖ ―chh‖ for 
―church,‖ and ―rect‖ for ―receipt.‖  Double letters 
were often written as single letters with a line or tilde 
above them.  Name abbreviations usually consist of 
the first three or four letters plus the last letter.  Both 
name and word abbreviations are normally written 
with the last letter of the abbreviation raised. 

If you‘re having trouble deciphering a word, try say-

ing it out loud in several different ways. 

If you can, read the remainder of the sentence and 

try to figure out what word would make sense. 

Find other words in the document that you can read, 

and use the letters in those words to piece together 
the letters in the words that you can‘t read. 

 
 

(Continued on page 6) 

mailto:LadyGeneo@roadrunner.com
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Ohio Computer Repair Service 
47375 Cooper Foster Park Road 

Amherst, Ohio 44001 
(440) 984-5265 

 

The Problem: 

Computers can be fun and frustrating at the same time. 
This may be a surprise to some, but 90% of everything that goes 
wrong with a computer is configuration related. The problem is, 

there are just too many settings to change and modify, and most 
people don't even know where these settings are.  

The Answer: 
You could read and study like I did for the last 14 years. You 

could experiment with your computers on a daily basis until you 
get it right, or search the Internet and find more sites than any 

ten people could read in a lifetime. You could accidentally break 
your computer more times than you care to remember, or you 

can call us, Ohio Computer Repair Service.  

The Result: 
A computer that runs all the time with no errors, no surprises, 

and does it faster and better than when it was brand new. 

Use a handwriting book to help piece the letters 

together.  Two books that you can use are The 
Handwriting of American Records for a Period 
of 300 years, by E. Kay Kirkham and Understand-
ing Colonial handwriting, by Harriet Strykker-
Rodda. 

If all else fails, you may need to consult a handwrit-

ing expert. 
 
Remember the sources are usually accurate, but not 
always.  Generally, the more hands it has passed 
through, the more times it has been transcribed or 
translated, the more you should worry.   
 
Remember you can‘t always believe everything you 
read.  It is important to evaluate the source and the pos-
sibilities for inaccuracies.  Below are a few things to 
keep in mind. 
 

When you find new information for your family tree, 

check for inconsistencies.  One example is the case 
where two children in the same family were born on 
dates that were impossibly close together.  
(However, keep double dates in mind.)  

When you suspect problems, try to verify the infor-

mation using other documents.  Most genealogical 
information can be found in more than one place, 
so take the time to check other documents out. 

Think about when the record was created.  Records 

that were made at the time of the event are more 
likely to be correct than sources that were made 
several years later.  For example, birthdates are 
often listed on death certificates, but you are more 
likely to get the correct date if you find it on a birth 
certificate. 

 
Remember, you can run into these types of errors not 
only when looking at handwritten documents, but also 
when you are looking at records that have been tran-
scribed from older original documents.  When reviewing 
a record with an unfamiliar handwriting style, it is impor-
tant to record all the letters of the alphabet on a sheet of 
paper and list the variations that you come across.  This 
self-training takes very little time and saves a lot of er-
rors and forgetting. 
 

Letter transpositions--‖Grover‖ becomes ―Rgover‖ 

or ―Smith‖ becomes ―Simth‖ 

Adjacent letters on the keyboard--‖Grover‖ be-

comes ―Grober‖ or ―Smith‖ becomes ― Wmith‖ 

Dropping a letter--‖Grover‖ becomes ―Grver‖ or 

―Smith‖ becomes ―Smit‖ 
 
Word spellings most often are just an inconvenience, 

(Continued from page 5) Problem Searching… but changes in name spellings are much more signifi-
cant.  It is important to keep different possible name 
spellings in mind when you are researching, so that you 
don‘t overlook records that might refer to your family. 

 

http://amberskyline.com/treasuremaps/oldhand.html 
http://www.genealogia.fi/faq/faq031e.htm 

 

You might want to try these websites to get some idea 
of what you might be up against.  Here is another ex-
ample.  Also you can go to Google and type in Old 
Handwriting and find more examples like I did. 

Genealogy Websites: 
 

Lorain County Genealogy Webpage 
http://www.rootsweb.ancestry.com/~ohlorain/ 
 
Names in Stone Cemetery Maps & Tombstones. 
http://www.namesinstone.com/ 
 
Free Genealogy Forms & Charts 
www.genealogysearch.org/free/forms.html 

http://amberskyline.com/treasuremaps/oldhand.html
http://www.genealogia.fi/faq/faq031e.htm
http://www.rootsweb.ancestry.com/~ohlorain/
http://www.namesinstone.com/
http://www.genealogysearch.org/free/forms.html
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APCUG 2011 User Group  
Conference 
 
APCUG is an umbrella group of PC User Groups that 
includes close to 200 individual Computer Clubs in the 
US and around the world.   This year, from July 15

th
 thru 

July 17
th
, the organization held a regional conference in 

the Cleveland area (Independence, Oh) and it was at-
tended by about 100 individuals from 30-40 individual 
user groups from around the country and Canada … 
including 2 from LCCUG (Sandee Ruth and Lou Koch). 
 

The conference included technical sessions ranging 
from simple how-to presentations that can be adapted 
for local club meetings (eg ―Win7 Tips and Tools‖ and 
―Ins and Outs of Skype‖) to more technical presenta-
tions (―Virtual Machines‖ and ―Drupal‖ for web site con-
struction). A number of vendors made presentations 
including Microsoft, Avast, Iolo (System Mechanic), and 
others. In addition there were numerous workshops and 
discussions aimed at promoting the exchange of ideas, 
opportunities and challenges that user groups are ex-
periencing throughout the country. There was plenty of 
opportunity to meet and socialize with members from 
around the country and make contacts which can be 
valuable. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Overall, the conference was very enjoyable, educational 

and provided ideas that may offer opportunities for 

LCCUG. Next year‘s Regional conference will be held in 

Canton and it will provide another opportunity for 

LCCUG members to attend and network with other us-

ers, learn more about the directions of the computer 

world (plenty of content for non-geeks as well as the 

more technical oriented) and experience the synergy of 

so many other clubs with similar interests to ours. Hope-

fully more LCCUG members will be able to attend next 

summer. 

    Lou Koch 

    Co-Vice President 

More Info on the APCUG 
Conference 
 
Lou Koch and I attended the annual APCUG meeting on 
the weekend of July 15.  The Association of Personal 
Computer User Groups has an annual meeting and 
sometimes a couple regional meetings.  I attended the 
annual meeting held 2 years ago in Newark, Ohio and 
Lou attended one several years before that when it was 
in Las Vegas. 
 
One of beneficial rewards of attending these meetings is 
getting to know those involved in other computer user 
groups around the country.  We can learn what issues 
they have and how they are handling them.  Everyone is 
suffering from decreased membership.  There are lots of 
different ideas on how to cope with the changing needs 
of their members.   
 
I attended sessions on Digital Photography, the iPad 
and Cloud Computing, Searching Tips and Tricks , 
Team Viewer update, Genealogy from OGS, Power 
Point Add-ons, Drupal (for making web pages) and So-
cial Media for the user group.  There were about 20 
other sessions held at the same times, many of which I 
also would liked to have attended. Fortunately most of 
the presentations are going to be posted online where 
we can access them. 
 
Sometimes it is the side comments that are made during 
lunch or before a session that make it just as likely to 
learn some cool new tidbit.  I will be sharing things in the 
months to come. 
 
The attendees were there because they like computers 
and the idea of sharing what we know in a user group 
setting.   Contacts are made and lots of old fashioned 
networking is made! 
 
Next year there will be a Regional meeting in Canton, 
Ohio and we hope to have even more of us attend and 
take advantage of learning opportunities like the ones 
we had.   
 
There will also be a joint meeting of the FACUG (Florida 
Association of User Groups) and  APCUG.   This will be 
a Bahamian Cruise aboard a Norwegian cruise ship!  
(http://www.facug.org/).  Imagine that!   Computers 
and Cruising!!  This will be the third year that the 
FACUG has done this, so they know what they are do-
ing!  We hope more of our members will take advantage 
of some of these upcoming opportunities. 

 

  Sandee Ruth 

  President  

http://www.facug.org/
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Sheriff Citizens Partnership  
Academy 
 

By President Sandee Ruth 
 
The Lorain County Sheriff‘s department made a presen-
tation to us last March letting us know how the Sheriff‘s 
department uses computers and computer forensics.   
 
While at our meeting they mentioned the upcoming 
Sheriff‘s Citizens Partnership Academy was going to be 
starting soon. 
Four LCCUG members took advantage and participated 
in the class.  Carole Doerr, Celesta Menges, Sue Kling-
beil, and myself. 
 
We joined about 18 other Lorain County residents par-
ticipating in a fascinating 8 week class.  For 8 weeks we 
met for 3 hours each Wednesday evening, learning 
about all the aspects of Sheriff‘s department work. 
 
I think I can speak for all of us when I say this was a 
fascinating opportunity.  One overriding issue that im-
pacted all of the department and the court system is 
funding cutbacks!  There are only 2 Sherriff deputies 
patrolling at a time! 
 

Overview of the department by Sherrif Stammitti 

Tour of the Lorain County jail wearing our Academy 

T-Shirts 

Learned about police dogs use in the department 

Then Lorain County Coroner, Paul Matus, gave us a 

2 hour slide show of dead bodies 

Heard from Lorain County Prosecutor Dennis Will 

and Common Pleas Judge Mark Betleski at the new 
justice center in Elyria 

Heard from the Sheriff office gang expert 

Learned to fire a semi-automatic gun, shooting 12 

bullets at a target 

Learned to do a building search and a traffic stop 

Heard about the Sheriff auxiliary officers that volun-

teer to help the department 

Heard from the Sheriff office drug expert 

Visited the Emergency Management and Homeland 

Security Office – seeing the facility and meeting 911 
operators 

Tour of the Sheriff Department garage (including 

tanks)  

Demonstration of equipment available to the depart-

ment swat team 

Learned about the department‘s involvement in the 

Northern Border Initiative and Sheriff‘s new boat for 
patrolling the coast. 

The wrap up was a dinner at Oberlin Inn where we 

each received a CD of photos taken throughout the 
program and a photo taken of us receiving a nice 
framed certificate handed to us by Sheriff Stammitti 

 
I highly recommend this class to anyone when it is of-

fered again next spring.  LCCUG membership chair, 

Dennis Smith took part in the Citizen Academy several 

years ago and he also spoke highly of this opportunity.   

What a Group of Volunteers 

History Sniffing 
  

It's as sneaky and creepy as it sounds. 

And despite improvements to web browsers -- the programs 

we use to surf the Internet -- this dubious tactic for tracking 

the sites we visit remains a threat to hundreds of thousands of 

people who haven't upgraded browsers to the newer versions. 

Towards the end of 2010, a new report showed how dozens of 

sites were checking visitors' surfing history by exploiting a 

browser feature most of us know well. 
 

A visit you make to any site is "remembered" by your 

browser so the next time the site name shows up in a search 

you make or on another website, it's colored purple instead of 

blue. That way, you instantly know you've been there before. 

But this handy feature, which has been around almost as long 

as the Internet, means your previous Internet activity poten-

tially could be "read" by simply looking for the color purple 

in your browser's records. 
 

There's one limitation: A spy program can't just "ask" your 

browser for a list of purple addresses. 

It has to ask: Has this person ever visited such-and-such web-

site? In other words, it must name the websites whose name-

color it wants to check. 
 

That's not as big a problem as it sounds though because his-

tory sniffing spies are usually interested in your interaction 

with a narrow range of other sites and the programs they use 

are capable of asking for a check on 20,000 names a second! 

(Continued on page 12) 

http://www.scambusters.org/
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Computer Systems Unlimited, Inc.  
 

We are a full service computer/peripheral 
sales and repair Company specializing in 
custom built Pc's, network design, software 
integration, and everything in-between. We 
are located in the small college town of 
Oberlin, Ohio, and for fourteen years have 

been providing unrivaled service to home users, small and large busi-
nesses all over Ohio as well as State and local government  agen-
cies.  All of our systems and networks are tailored to meet the individ-
ual needs of our customers. 
 

Onsite service and repair for all networks and systems, In house 
service and repair, Pick up and drop off,  Printer repair and cleaning, 
Laptop repair, Software troubleshooting, Custom designed networks 
and pc's, MAC repair, Parts replacement & Expert advice and support 
and Data Recovery. 
 

* Computer Systems Unlimited is happy to offer a 5% discount 
on all computer systems ordered by LCCUG members.  
* Computer Systems Unlimited will also offer a free computer 
diagnostics check, (a $25 value), for all LCCUG members.  
 

Visit our web site at www.csuoberlin.com for more of what we can do. 

Store Hour Monday 9-5:30 - Thursday 9-5:30 - Friday 9-5 - Saturday 9-1  

More about Plum 
Brook  
 
By Sandee Ruth 
 

On April 26, 20+ members of LCCUG took a tour of the 

NASA Plum Brook facility in Sandusky.   
 

I mentioned in the July newsletter that a DVD about the facil-

ity, Of Ashes and Atoms could be borrowed from the librar-

ies.   
 

I have since learned more that might be of interest on this 

topic. 
 

Club member, Joe Harrold, worked at the facility when it was 

closed in 1973.  Joe has some thoughts he wanted to share 

about the Plum Brook facility, also at the end of this story is 

some information about how you can get a free copy of that 

DVD. 
 

“I see in the July LCCUG Newsletter that you are 

referencing the club's visit to the NASA Plum Brook 

Station and suggesting people may want to view that 

DVD "Of Ashes and Atoms" about the Plum Brook 

Reactor Facility.  
 

It is a very interesting and informative historical 

DVD, but solely about the Reactor Facility and its 

former employees.  I do have my own original copy 

as a former employee at NASA Plum Brook.  
 

However, as a former employee at the Plum Brook 

Station from 1964-1974, and later from 1974-1994 

at the Lewis Research Center in Cleveland, I have 

another viewpoint about the Plum Brook closing.  
 

The rest of the Plum Brook story should also have 

been told. To me the DVD was a very parochial 

treatment about the closing of Plum Brook. 
 

Even though the AEC and NACA Reactor Project 

gave a rebirth to the Plum Brook Station, the total 

1950s to 2011 Plum Brook story goes way beyond 

solely the Reactor Facility and its employees.  
 

In the late 1950s the Plum Brook Station also be-

came the home of the NASA Lewis Research Cen-

ter's Rocket Systems Division, its numerous test and 

support facilities (some as very expensive invest-

ments), and its many employees.  
 

In the early 1970s, the new Space Power Facility, a 

$28M investment, was built and later became an-

other Plum Brook Station operating research  Divi-

sion. 

I worked in the Rocket Systems Division and, for a 

period in its early days, was loaned to the Space 

Power Facility.  
 

Our LCCUG visit to the Plum Brook Station was 

limited to this Space Power Facility, recognized as a 

unique world class simulated space environment re-

search facility. The other major Plum Brook facilities 

were only mentioned at that visit. 
 

Actually in 1973, the demise of the Reactor Facility 

took the rest of the vast Plum Brook Station space 

research operations and their employees down with 

it. Also, several hundred employees in Lewis Center 

in Cleveland were affected during this same period. 

Because of budget constraints and NASA eliminating 

nuclear programs, it became convenient for NASA 

and Lewis Research Center to declare the Plum 

Brook Station as a nuclear facility simply because of 

the Reactor Facility, even though that was a stretch. 

In the final days of the Plum Brook Station, in 1973 

& 1974, the space research value at the Plum Brook 

Station for Lewis Research Center and also for 

NASA far exceeded that solely described about the 

Reactor Facility.  
 

The DVD only faintly recognizes others at Plum 

Brook and that is unfortunate.” 

Joe Harrold 
 

Joe also has a collection of scanned documents and newspaper 

clippings saved as his own memorabilia file about that 1973 

"Black Friday" at Plum Brook.  
 

“If you read the many articles you may get a feel that closing 

of the Reactor Facility was a fraction of the loss to NASA 

caused by conveniently closing Plum Brook.” 
 

If you would like a copy of these articles, let Sandee Ruth 

know and we will copy them on a DVD for you. 
 

++++++++++++++++ 
 

The DVD, Of Ashes and Atoms: A Documentary on the 

NASA Plum Brook Reactor Facility (NASA SP-2005-4605)   

is available for free if you call and request a copy. 
 

There is also a book called NASA‟s Nuclear Frontier, that 

may be available, as well. NASA Info Center 

http://www.csuoberlin.com/
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LCCUG O NGOING  CLASSES  
AND  WORKSHOPS  

 ALL  ARE  FREE  AND  OPEN  TO  THE  P UBLIC  

 

  Date:  Tuesday 2011 
  Time:  5:30 - 8 pm  Instructor:  Micky Knickman, et al. 

  Place:  Amherst Church of the Nazarene 
   210 Cooper Foster Park Rd.,44001 

 

 

   Learn how to repair or update your computer by changing 
hard drives, memory, CD ROMs, etc. 
 Members are encouraged to bring their computers any-
time before 7:30 pm for assistance from Micky, Neil or other 
knowledgeable members.  

Problem Solving Workshop 

NEED HELP?— 
Here‘s Who to Contact: 

 
Neil Higgins 
  

 440-967-9061 - higgins.neil@gmail.com 
 Evenings 6 p.m. -10 p.m. + Weekends 
  Hardware, Linux & Windows Operating Systems,  
 Tweaking your system 

 

Micky Knickman 
     

 440-967-3118 - micky@knickman.com 
  Evenings 5 p.m. – 7:30 p.m. + Weekends 
   General Software Configuration, Hardware Installation,  
 Basic to Advanced Windows 
 

Lou Koch 
    

 440-985-1585 - lkkoch@centurytel.net 
   Microsoft Office: Excel, Word, PowerPoint, Publisher, Access, & 
 Outlook, Basic to Advanced Windows 
 

Edie Lewandowski 
    

 440-282-4188 - elew@erienet.net 
   Daytime - midnight 
   Desktop Publishing, General File Management, Eudora Email, 
 MSWorks Tools,  
 

 Richard Barnett 
      

 440-365-9442 - Richard216@aol.com 
    Evenings & Weekends 
   General Software Configuration, HardwareInstallation, Basic to 
 Advanced Windows & Web Page Design 

 

Sandee Ruth  
   

 440-984-2692 - sandee29@gmail.com 
  6 p.m. - 10 p.m. except when at work 
   Basic Word Processing, Windows,  & Web Design 

   Advanced Internet  
 

Jeff Kasler 
    

 440-967-7142 - Jeffk@roadrunner.com  
   10 a.m. - 7 p.m. 

   Burning CDs using Record Now  
 

David Kennett 
    

 440-327-8624 - w8kfj@yahoo.com 
 9 a.m. - 8 p.m.   
 Video Editing & DVD Burning 
 

Cathy Ratcliff 

 

 therats1@verizon.net 
 Though she lives in Coshocton, you can call  
 740-327-1483  before 8 pm 
 Paint Shop Pro, other Photo Editing programs, 
 Microsoft Office programs  
 
Keith Kuhn 
    

 440-967-6509 - kthkuhn@yahoo.com 
 8 a.m. - 11 p.m.   
 Downloading Music & Burning CDs 

Don’t forget to check the Members’ page for up-to-date infor-

mation about programs & events: 

http://www.lccug.com/members 

Date: is Cancelled until September 
Time:  
Instructor:  Pam Rihel 
Place:  LCCC Learning Center. 
  St. Joe‘s Com. Center,  21st & Broadway 

  

 Learn more about finding your ancestors with public re-
cords & online websites.  How to start & sources to use. 
 

You must register   -  Phone: 440-277-6076  or 
Email: LadyGeneo@roadrunner.com 

Genealogy Class 

Date:  Cancelled for  Summer 
Time: 3:00 - 5:00 pm 
Instructor:  Jean Griffith 
Place:  LCCC Learning Center. 
  St. Joe‘s Com. Center,  21st & Broadway 
 

Bring your questions if you‘d like.  Jean will start with the 
basics and move on to intermediate topics if time allows. 
Learn MS Word, copying & pasting, for-matting text, saving 
files, basic file management, basic PC maintenance, etc 

 

Register by calling LCCC Learning Center:    
440-366-4507 

Beginning to Intermediate 

 Computing 

Looking for members who are creative and would like to volunteer 

their time to teach a class.  The subject is your choice.  You can 

contact any board member or call Dina Ferrer at 233-7240 ir 366-

4506 to schedule your class at the LCCC Learning Center. LCCUG 

needs volunteers like you to show our members new subjects about 

computing. 
 

We are hoping to hear from some new volunteers soon. 

Thanks for participating in our teaching programs. 

Space Reserved for a New Class 

mailto:higgins.neil@gmail.com
mailto:micky@knickman.com
mailto:lkkoch@centurytel.net
mailto:elew@erienet.net
mailto:Richard216@aol.com
mailto:sandee29@gmail.com
mailto:Jeffk@roadrunner.com
mailto:w8kfj@yahoo.com
mailto:therats1@verizon.net
mailto:kthkuhn@yahoo.com
http://www.lccug.com/members
mailto:LadyGeneo@roadrunner.com
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August 2011 Classes 

Class Type Location Registration August Time More Info 

Classes / Workshops 

Problem Solving 
Micky Knickman 

Amherst Church of 
the Nazarene 
210 Cooper Foster 
Park 

  
Not Required August 16, 

2011 
5:30 to 8:00 

pm 
Page 10  

Genealogy Class 
Online & Off 
Pam Rihel 

LCCC Learning Center 
St. Joe’s Com. Center 
21st & Broadway 

 

Reg. required  
 

LadyGeneo @ 
roadrunner.com 

Cancelled until 
September 

 3:00-5:00 pm Page 10 

Beginning to Inter-
mediate Computing 
Class 

LCCC Learning Center 
St. Joe’s Com. Center 
21st & Broadway 

 

Jean Griffith 
 

Register by call-
ing:    

440-366-4507 

Cancelled for 
Summer  

 3:00-5:00 pm Page 10 

Is there a class you would like to teach or a class you would be interested in attending, please let one of our 
officers know. 

We want to fill this last row with something new to be taught.  

COMPUTER REPAIR 

PRINTERS & SUPPLIES 

UPGRADES 

* CUSTOM PC'S & LAPTOPS 

* CALL FOR BEST PRICES 

* EDUCATION DISCOUNTS 

LCD MONITORS & TVS 

365-2288 - Elyria  1-800-238-8973 - USA  
 

591 Cleveland Street   Elyria, Ohio  44035 

Shop at    www.ROYALBUSINESS.com    and save $$$ 
 

Financing Available  -  90 days same as cash 

The Lorain County Chapter  
of OGS 

is having it‘s next  meeting on : 
 

 

August  8, 2011  “Bringing Your Ancestor to Life”  
Presentation by Deborah Abbott, PhD.  She will talk 
about how to build a meaningful family history when 
only a photograph, artifact, etc., is all that you have.  
Emphasis will be placed on the use of and location of 
various resources such as social histories, newspa-
pers, Internet searches, and other documents needed 
to build the story. 
 
Our regular meetings will start in August.  Meetings are 
held the 2nd Monday of the month in the North Ridge-
ville Library on Bainbridge Rd., east off Rt. 83-just 
south of Rt. 20.   
 
Meetings start at: 7:00 PM for the program, with Social 
time at 6:30 PM;    Meetings are free and open to the 
public. 
 
For more information you can contact:  
Jean Copeland: atmmom1@aol.com or  
Pete Hritsko:  hritsko@centurytel.net 

L C C U G

Members, if there is something you would like 
to have me put into our newsletter just let me 
know at one of our meetings or email me at: 
newsletter@lccug.com.  I would be more 
than happy to oblige you.  Pam Rihel 

mailto:LadyGeneo@roadrunner.com
mailto:LadyGeneo@roadrunner.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.royalbusiness.com/
http://www.royalbusiness.com/
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
mailto:atmmom1@aol.com
mailto:hritsko@centurytel.n​et
mailto:newsletter@lccug.com
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Understanding Hyphens 

and Dashes 

Word supports the use of both hyphens and dashes. 
Actually, it supports three types of hyphens and two 
types of dashes. It is important to understand how Word 
handles each of these, as they can affect the appear-
ance of your document. 
 

Regular hyphens. These are created by simply 

typing the hyphen key. This is the key that is to the 
right of the zero key on the keyboard. It is some-
times mistakenly called a dash key. Regular hy-
phens are used to create compound words, such as 
―mix-up,‖ or to indicate a minus sign in an equation. 
If a compound word appears near the end of a line, 
the second word will be displayed on the next line, if 
necessary, with the first word and hyphen remaining 
on the previous line. 

Optional hyphens. These are created by pressing 

CTRL+- (CTRL and the hyphen key). Optional hy-
phens are typically used in the middle of a word, 
between syllables, to indicate where a word should 
be broken between lines, if Word deems it neces-
sary. Optional hyphens are the type inserted auto-
matically when you use the Hyphenation tool in 
Word. The optional hyphen does not appear on any 
printout unless it is actually used at the end of a line. 

Non-breaking hyphens. These are created by 

pressing CTRL+SHIFT+- (CTRL+SHIFT and the hy-
phen key). Non-breaking hyphens are used in com-
pound words to indicate that both words and the 
hyphen should be treated as a single word when 
Word is forming lines. In this case, the compound 
word will never be broken over two lines. It is also 
helpful to use non-breaking hyphens in phone num-
bers. 

En dash. An en dash is a typographic dash that is 

as wide as a lowercase ―n‖ character. These dashes 
are typically used to denote ranges of numbers, as 
in 3–7. You create an en dash by pressing CTRL and 
the minus sign on the numeric keypad. You can also 
create it by holding down the ALT key as you type 
0150 on the numeric keypad. If necessary, Word will 
break a line right after the en dash, not before it. In 
other words, the en dash always stays with the char-
acters immediately preceding it. 

Em dash. An em dash is a typographic dash that is 

supposed to be as wide as a lowercase ―m‖ charac-
ter. In Word, however, the em dash is twice as wide 
as the en dash. (The width of the em-dash can vary 
from font to font.) Em dashes are used in creating 
breaks in sentences, between two separate 
thoughts. Word will substitute an em dash automati-
cally as you are typing if you type a word, two hy-
phens in a row, and another word. You can also ex-
plicitly enter an em dash if you press CTRL+ALT and 

the minus sign on the numeric keypad, or you can 
enter one by holding down the ALT key as you type 
0151 on the numeric keypad. If necessary, Word 
will break a line right after the em dash, not before 
it. The em dash always stays with the word immedi-
ately before it. 

 

The foregoing items describe the behavior and pur-

pose of each of the hyphens and dashes used in 
Word. If you are using a dash or hyphen and it does 
not behave as indicated here, then you may be us-
ing the wrong type. For instance, if a word will not 
break as you expect between two lines, you may be 
using a non-breaking hyphen instead of one of the 
other types. 

 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by 

permission. Thousands of free Microsoft Word tips can be found 

online at http://word.tips.net. 

Here's an example. You visit a site selling jeans. As soon as 

you arrive, the site checks for "purple" names of all its com-

petitors on your computer to see if you visited them. 
 

Maybe it also checks for names of sites popular with male or 

female surfers and scores of other special interest sites, which 

help create a picture of you, your gender, age range, fashion 

taste, whether you're an impulsive or cautious shopper and 

what your likely budget is.  All in less than a second. 
 

It can then present you with a specially-made page that will 

appeal to you, with jeans that match your spending profile. It 

can even adjust prices to make sure it beats competitors. 
 

How to Avoid History Sniffing 
That may or may not be a bad thing, but the point is that users 

don't even know it happened -- that they're effectively being 

spied on via this history sniffing. 
 

Hardly surprising then that these antics recently led to the 

launch of a class action suit against one online company, al-

leging invasion of privacy. 
 

Worse, the technique can be used for much more dubious 

purposes like providing you with links that target your inter-

ests, increasing the chance you'll click on them, but which 

really link to malware and phishing sites. 

Most popular web browsers have now been changed to block 

history sniffing. Apple's Safari and Google Chrome were 

reportedly first. But Firefox and Internet Explorer eventually 

followed suit, though Firefox pointed out that it's possible to 

switch off the color feature from within some earlier versions 

of their browser. 
 

But how is the average user supposed to know all this and, 

equally, how to make any settings change required to switch 

it off? 
 

And how are they supposed to know about the need to up-

(Continued from page 8) History Sniffing 

(Continued on page 17) 
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MS PowerPoint: Add Text 
That Can’t Be Edited to 
Your Slides 
 

Sometimes we need to add text to a slide that we do not 
want edited in the usual manner. Maybe we need a logo 
in the corner or a disclaimer or maybe a web address… 
whatever it is that you‘re looking to have on all slides of 
a presentation and it should be left alone. 
 

If you‘re looking to add text to a slide for a presentation 
or template that cannot be removed or edited through 
the traditional methods then you may be disappointed. 
 

Our first thought goes to the Slide Master – as it rightly 
should. 
 

All you need to do to ensure you‘ve got what you want 
on the slides without further editing or accidental dele-
tion we‘ll simply add it to the Slide Master. 
 

For those of you who haven‘t used this little gem before 
you‘ll need to head over to the View tab / Slide Master 
button. 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Choose which slide layout you want the information 
on from the left – or if it‘s all of them then choose the 

Windows Media Player 
Volume Shortcut 
 
Here‘s a quickie for Windows Media Player 11. Next 
time you need to adjust the volume of your music or vid-
eos, don‘t reach for the mouse, but instead let your  
hand travel up to the function keys.  
 

F7 – To Mute 
F8 – For Volume Down 
F9 – For Volume Up 

 
 
 
 
 

That‘s a heck of a lot simpler than aiming a cursor! Now, 
pump up the volume! 
 

~Andrew  
 

What Time is It, Google? 
 

I stumbled across this neat trick for Google the other 
night when a friend of mine wanted to know what time it 
was in Japan. Usually, I‘d just use the Windows clock, 
change the time zone, etc., etc., but for this, I decided to  
Google it and see what happened. 
 
Besides, I don‘t necessarily have a giant wall full of  
time-zone specific clocks to consult. 
 
So, all you do is browse over to Google, and in the  
search box, type: 
 

―What time is it in (Insert location here)― 
 
Like this: 
 

 

 

 

 

 

 

 

 

 

 

 

Lo and behold, there‘s the time! I guess you wouldn‘t 
want to call anyone in Japan right now, would you? 
 

Give it a try today! 
 

~Andrew  
 

Reprinted with permission from WorldStart.  Visit 

http://www.worldstart.com and subscribe to their 

informative newsletters. 

http://www.google.com/
http://www.worldstart.com
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very top slide as that‘s the one that all the layouts are 
based upon. 
 

Be sure to enter any text using a Text Box. All the 
placeholders you insert are the editable pieces of a slide 
layout. 
 

Once done you simply need to close the Slide Master 
using the Slide Master tab. 
 
 
 

 

 

 

 

 

 
 

That‘s it… you‘re information is going to appear on all 
your slides without any hassle at all. 
 
~ April 
 

Reprinted with permission from WorldStart.  Visit 

http://www.worldstart.com and subscribe to their 

informative newsletters. 

(Continued from page 13) MS PowerPoint... 
 

What To Do When Your  
System Freezes 
 

by Gregory Anderson 
 

Big programs do it. Small programs do it. Good pro-
grams do it. Bad programs do it. Old systems do it. New 
systems do it. All programs do it, and all systems do it. 
Freezing is a fact of computing life, whether it‘s an indi-
vidual application that stops responding or the entire 
system that locks up. Anytime this happens your work is 
at risk, but freezing doesn‘t always have to end in catas-
trophe. We‘ll help you understand how to work through 
issues when they arise and recover from them after the 
fact. 
 

General Tips  
Regardless of the situation, there are a few general 
guidelines that can help keep you sane and your system 
stable.  First, above all, be patient. What at first looks 
like a freeze can often just be slow processing. When in 
the middle of resource-intensive activities, such as edit-
ing video, burning a DVD, or copying large files, many 
applications and machines run especially slowly and 
may even appear to hang. Drastic steps are sometimes 
necessary, but they usually come with a cost. Don‘t start 
forcing anything to close or shut anything down until 
you‘re certain it‘s not just taking a long time to process 
and you‘ve exhausted all other possibilities. As always, 
protect yourself against the inevitable (but hopefully 
rare) freezes and crashes that can‘t be prevented. Fol-

low the basic rules of computing. Save early and often. 
Schedule and confirm regular backups of important 

data. Don‘t let 
hardware or 
software prob-
lems linger—
troubleshoot 
and repair/
replace as 
soon as feasi-
ble. Use anti-
virus and an-
t i s p y w a r e 
tools to protect 
your system 
from infection 

or invasion; many freezes can be attributed to the im-
pact of malware. 
 

Program Freezes 
Sophisticated commercial applications normally provide 
some sort of moving progress indicators to let you know 
they‘re still working and not frozen, but not all applica-
tions have these, and they don‘t always work correctly. 
When you think your program is frozen, use your mouse 
to try switching applications. Sometimes working on 
something else gives the bogged-down application time 
to recover or catch up. 
 

If switching to other applications doesn‘t work, or if the 
mouse isn‘t responding, try the ALT-TAB keyboard com-
bination. This shortcut displays each of the currently 
open windows and lets you toggle among them. Press 
TAB repeatedly while holding ALT to rotate through 
them. Simply release both keys when you reach the ap-
plication you want. 
 

Switching out to another open program, either for just a 
moment or for a longer period, can help determine 
whether the application in question is responding.  If 
nothing else is open, or if ALT-TAB isn‘t responding, try 
the WINDOWS-M combination instead. This shortcut 
minimizes all open applications, returning your screen to 
the Windows Desktop.  Sometimes, it will also reveal a 
dialog box or warning message hidden underneath 
other open windows, which may prevent programs from 
responding while they await input. 
 

The next step is to try re-launching the offending appli-
cation or opening another instance of it. Sometimes this 
will nudge the system into reactivating the first open 
window in that program or, at the very least, let you 
complete your activity within a different session. This 
won‘t work every time, and it may not help you access in
-progress data, but it won‘t hurt if the application is fro-
zen already. 
 

If nothing you do induces the application to respond, 
use the ―X‖ button at the top right to try and close it. The 
application may not respond to the close request imme-

(Continued on page 15) 

Pressing ALT-TAB may let you switch among 
open applications in attempting to avoid one that’s 

not responding. 

http://www.worldstart.com
http://www.smartcomputing.com/
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diately, but this is another opportunity to practice pa-
tience. The program may take a minute or two to close, 
or it may take that long to generate the message that it 
isn‘t responding.  If the ―Not Responding‖ message ap-
pears, and if you‘ve exhausted all other options, force 
the application to close by clicking End Task (or simi-
lar). 
 

Sometimes, though, an application won‘t even respond 
to the Close button or generate an End Task dialog 
box.  If ending a program this way doesn‘t work, you‘ll 
have to go to the Task Manager. Access the Task Man-
ager by right-clicking the Taskbar and selecting Task 
Manager from the context menu or by pressing CTRL-

ALT-DELETE and clicking Start Task Manager from the 
on-screen menu. Start with the Applications tab. Locate 
the program in question and click End Task.  If that 
doesn‘t do anything after a few minutes, navigate to the 
Processes tab.  Try to locate your problem application 
by name. Usually, you can figure out the correct proc-
ess based on the Image Name field (click the Image 
Name label to sort alphabetically), though some appli-
cations are a little more cryptic and require cross-
checking the Description field, as well. Sorting by CPU 
or Memory usage may also provide a clue as to what‘s 
hogging all the resources. When you find a culprit, se-
lect it and click End Process at the bottom right. Con-
firm any warning messages with another End Process 
selection. This should bring a quick end to any applica-
tion that‘s stopped responding, but it doesn‘t mean your 
system is back to normal. After you‘ve had to do an 
application-killing End Task or End Process, it‘s a good 
idea to reboot and let the system come back up in its 
natural state. 
 

System Freezes 
Full system-wide freezes can be a little more difficult to 
figure out. For one thing, it‘s hard to identify a single 
application or process at fault if you‘re multitasking 
when things go awry. It‘s also harder (by definition) to 
navigate and investigate when nothing is responding, 
including Windows. However, just as with application 
freezes, don‘t give up too early. Look for signs of life 
that might indicate the system is processing and not 
frozen. Good indicators include flashing activity lights, 

(Continued from page 14) Program Freezes... 

The end task dialog box, either generated from an application’s 
Close (“X”) button or from the Task Manager, may force a frozen 

program to close. 

the whir of a churning hard drive, or indicator icons and 
bars that move only infrequently. If it looks like things 
might actually be moving, even if only at a snail‘s pace, 
wait a little longer. 
 

When signs of life cease, or when you run out of pa-

tience, try a few simple navigational tricks. Use the ALT-
TAB shortcut as previously described to see if anything 
happens.  Try other keyboard shortcuts such as WIN-
DOWS-M (minimize all) or WINDOWS-D (show the 
Desktop).  Disconnect and reconnect your mouse and 
keyboard. You can also try removing peripherals not in 
use, such as portable drives, printers, or other devices. 
Try removing any recently added hardware. USB drives, 
especially older ones, are notorious for creating re-
source conflicts that can bring a system to its knees. 
 

If the system is still not responding, you‘re left with little 
choice but to shut it down. Take the gentle route first. 
Press CTRL-ALT-DELETE and see if you can get to a 
Log Off or Task Manager window. Or try to get to the 
Start menu with its shutdown options, either via the 
mouse or by pressing the WINDOWS key. Next, press 
ALT-F4, which will try and close either the currently ac-
tive application or may shut down the system.  If your 
machine has Shutdown, Standby, or Restart keyboard 
buttons (as many notebooks do), try using them. Addi-
tionally, many desktop cases have a Restart button built 
into the front. Finally, if nothing else works, press and 
hold the Power button to bring the machine down. 
Physically pulling the plug or removing the battery is 
your absolute last resort and can create hardware prob-
lems, so you should avoid such drastic measures if at 
all possible.  
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

The Windows Task Manager provides detailed access to 
all open applications and processes, providing access to 

a forced End Process or Log Off option. 

http://www.smartcomputing.com
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Monthly Close-Out 

Dates 
Different companies handle their work load differently. Some 

companies are tied to the regular calendar, with a “work 

month” beginning on the first and concluding on the last 

workday of the month. Other companies adjust the monthly 

starting and ending dates to meet particular needs for account-

ing or other purposes. 
 

You may have a need to figure out your particular close-out 

date for a month. By using a couple of functions from Excel‟s 

Analysis ToolPak, you can make quick work of this task. 

The primary function to use is the WORKDAY function. This 

function allows you to determine a particular workday before 

or after a starting date. For instance, if you needed to know 

the workday three days before today, you could use the func-

tion in this manner: 

 
 

The first argument for WORKDAY is TODAY, which pro-

vides today‟s date. The second argument indicates how many 

days before or after today you want. Remember that WORK-

DAY only returns actual workdays, Monday through Friday. 

(Well, it returns the dates for those workdays. It‟s not like the 

WEEKDAY function, which returns 0 through 7 for the day 

of the week.) In this particular instance, if today is a Tuesday, 

then three workdays before Tuesday is Thursday, and 

WORKDAY returns the date for that Thursday. 

The next function you need to use is EOMONTH, which re-

turns the date for the end of the month a given number of 

months before or after a particular date. To find the end of the 

current month, you would use the function in the following 

manner: 

 
 

The first argument for EOMONTH is TODAY, which pro-

vides today‟s date. The second argument indicates how many 

months before or after that date you want the end of month 

for. Since the argument is 0, this usage of EOMONTH returns 

the last day of the current month. 

If you combine the WORKDAY and EOMONTH, you can 

determine the third workday before the end of the current 

month, in this manner: 

 
 

If you wanted to figure out the third workday before the end 

of a different month, just replace the TODAY function with a 

date in the month you want. For instance, if cell C2 contains a 

date, and you want to know the third workday before that 

date‟s end of month, you would use the following: 

 

=WORKDAY(TODAY(),-3) 

=EOMONTH(TODAY(),0) 

=WORKDAY(EOMONTH(TODAY(),0),-3) 

=WORKDAY(EOMONTH(C2,0),-3) 

It should be noted that this formula actually returns the third 

workday before the last day in the month, not the third work-

day before the last workday in the month. This comes into 

play, of course, when dealing with months that end on Satur-

day or Sunday. If a month ends on a Saturday or Sunday, the 

function returns three workdays before that date, which would 

be a Wednesday. However, if you wanted the date three days 

before the last workday (which is Friday), you actually want 

Tuesday, not Wednesday. 
 

In this case, the formula gets much more complex because 

now you need to check to see if the actual end of the month is 

a Saturday or Sunday. Again assuming that you are basing 

everything on a date in C2, you could use the following for-

mula: 

 
 

If the end of the month in C2 is a Saturday (7) or Sunday (1), 

then the formula calculates the workday one day before (the 

Friday) and then figures the workday three days before that. 

Otherwise, the regular formula that calculates the third prior 

workday is used. 
 

If you want the formula to be even more accommodating, 

remember that WORKDAY can compensate for a set of holi-

days, as well. The easiest way to allow for holidays is to put 

the dates of a set of holidays into a named range (such as 

“Holidays”), and then add a third parameter to the WORK-

DAY function, as shown here: 

 
 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted 

by permission. Thousands of free Microsoft Excel tips can be 

found online at http://excel.tips.net. 

=IF(OR(WEEKDAY(EOMONTH(C2,0))=1,WEEKDAY
(EOMONTH(C2,0))=7),WORKDAY(WORKDAY(EOMONTH
(C2,0),-1),-3), WORKDAY(EOMONTH(C2,0),-3)) 

=WORKDAY(EOMONTH(C2,0),-3,Holidays) 

http://www.loraincounty.com/
http://excel.tips.net/
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After The Thaw: Recover From A Freeze 
Whether you manage to get things moving again or have to bring the application or system down, there are a few 
steps to take after a freeze. 
 

Reboot. Even after just closing an application, your mem-
ory or other processes may have become corrupted. Be 
safe and restart the system. 
 

Safe Mode. If you bring down the system without using the 
Windows Shutdown option, boot up in Safe Mode. Win-
dows will often prompt you after a system crash, or you 
can press F8 during the boot process for a menu with the 
option to boot into Safe Mode. After loading into Safe 
Mode, reboot again with a clean restart before proceeding 
with normal activities. 
 

Recover data. If you had to close out in the midst of work-
ing on something, your-in-progress data may be lost. But 
you may be able to recover at least part of your files.  Mi-
crosoft Office will often AutoRecover documents after a 
crash, and temporary or archived files may provide some 
assistance. 
 

Watch out. Keep a close eye on the system‘s perform-
ance and your usage for a while, so that if a freeze recurs, you can detect a pattern and, hopefully, identify the 
cause. 
 

Save early, save often. Freezes can happen at any time, without warning.  Make a habit of saving your work regu-
larly.  Don‘t forget to schedule and verify regular system backups, as well. 
 

Reprinted with permission from Smart Computing.  Visit http://www.smartcomputing.com to learn what Smart Computing  
can do for you and your user group! 

After a freeze, boot back up into Safe Mode  
before restarting normally. 

grade? Although, for instance, Google Chrome automatically 

upgrades, others generally don't. 
 

Instead, they bombard users with messages that a new ver-

sionis available, but many users get stuck in their ways and 

often are reluctant to upgrade for fear they'll lose bookmarks 

and settings (even though they probably won't). 
 

The result is that hundreds of thousands of users, possibly 

even more, haven't upgraded to the more secure versions. 

Action: There are two things you need to do here. 
 

First, make sure you are using the latest version of your 

browser. 
 

How you do this depends on the browser. Rather than us go-

ing into detail here, if you don't know how, just do a search 

with the words "How do I check my version of" followed by 

the name of the browser. 
 

Second, in addition to blocking history sniffing, most recent 

browser versions also have tightened up on other aspects of 

security and privacy. 
 

Take the opportunity to get to know your browser by reading 

the help files or visiting its website. 

Most PC attacks come via the Internet, so it's just plain com-

mon sense to know how to use your browser to protect your-

self. 
Copyright Audri and Jim Lanford.  All rights reserved. 
Reprinted with permission.  Subscribe free to Internet 

ScamBusters at http//www.scambusters.org 

(Continued from page 12) History Sniffing... 

MIDDLE AGE TEXTING 
CODES: 
 
ATD - at the doctor. 
 
BFF - best friend fell. 
 
BTW - bring the wheelchair. 
 

BYOT - bring your own teeth. 
 
FWIW - forgot where I was. 
 
GGPBL - gotta go, pacemaker battery low. 
 
GHA - got heartburn again. 
 
IMHO - is my hearing aid on? 
 
LMDO - laughing my dentures out. 
 
OMMR - on my massage recliner. 
 
ROFLACGU - rolling on floor laughing and can't 
get up. 
 
TTYL - talk to you louder! 

http://www.smartcomputing.com/
http://www.smartcomputing.com
http/www.scambusters.org
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Converting Documents to 
PDF 
 

By Wayne Comstock, Member, South 
Walton Computer & Technology Club 
(SWCTC),  
Florida  http://southwalton.apcug.org/  
Walaco@gmail.com 

 
One technique I frequently use to save an online article or 

publication is to convert and save it as a PDF file. Once con-

verted, Adobe Reader software then becomes an excellent 

way to open, view and read any converted document off of 

your computer screen. PDF documents can also be easily 

emailed to others as an attachment.  

 

You can convert to PDF from any file you can print, includ-

ing Microsoft Word, Works, Excel, PowerPoint and digital 

pictures. Rather than being printed ink to paper the file be-

comes a PDF file. If the document is already a paged PDF file 

you can convert the file to just the pages you select and select 

your PrimoPDF printer to convert. 

 

You will need PDF conversion software to accomplish this. I 

recommend the Free PrimoPDF program. It's free, easily in-

stalled and available at: www.primopdf.com/index.aspx 

 

1.  Browse Primo web site and download one of the two 

installers available for 32 and 64-bit versions of Windows. 

Ensure that the version you download corresponds to your 

operating-system. 

 

2.  When prompted, select a download location which you 

can find easily, such as your „Desktop‟ or „My Documents‟ 

folder, and click OK. 

 

3.  When the download is complete, double-click the file 

named FreewarePrimoPDFXX.exe (XX being a 2-digit 

number) which would have appeared in the location you 

selected in the previous step. 

 

4.  Follow the simple instructions to complete the installa-

tion. A system-restart is NOT required. 

 

PrimoPDF installs itself as a virtual printer in the Windows 

Printers and Faxes device group. This allows any software 

with print functionality to output files to PrimoPDF for quick 

and easy PDF conversion. 

 

To convert a document to PDF: 

1.  Open a document in any printable program (e.g. Microsoft 

Word, Works etc.), and select File >Print. 

 

2.  In the printer dialog, select PrimoPDF from the dropdown 

menu and click OK to complete the print, and launch the Pri-

moPDF interface. 
 

3.  Select one of the Creation Profiles for the document Qual-

ity you need to achieve. A detailed explanation can be found 

in the PDF Creation profiles section of this guide. Point your 

cursor at each button to define. 

4.  Select the Save As dropdown menu to set a name and loca-

tion for the created PDF. 
 

Ask when creating PDF – Allows you to rename the PDF 

and select a save-location. 
 

Specific Folder – Allows you to select a save-location 

while using the name of the document which is being 

converted. This option returns you to the PrimoPDF in-

terface should you wish to change other settings for the 

same conversion. 
 

5.  Click the Create PDF button to convert your document. 

  

6.  Alternatively, if you wish to save the PDF under a differ-

ent name of directory, just click Cancel and you will be re-

turned to the Save As dialog. 
 

There are many more options and features available. 

(Appending a PDF) Go to the web site below and download 

the PDF Primo detailed User Guide. 
 

http://www.primopdf.com/pdfs/PrimoPDF_V5_User_Guide.pdf 

 
There is no restriction against any non-profit group using this article as long as it 
is kept in context with proper credit given the author. The Editorial Committee of 
the Association of Personal Computer User Groups (APCUG), an international 
organization of which this group is a member, brings this article to you. 

 

http://southwalton.apcug.org/
mailto:Walaco@gmail.com
http://www.primopdf.com/index.aspx
http://www.primopdf.com/pdfs/PrimoPDF_V5_User_Guide.pdf
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Home Computer  

Security  
 
By Wil Wakely, President, Seniors Computer Group,  
California  April 2011 issue, Bits and Bytes, The Official 
Electronic Newsletter of the Seniors Computer Group 
www.SCGsd.org        wilw@adnc.com 
 
For this article I will be quoting extensively from work 
that was produced by Carnegie Mellon University for 
FedCIRC and the General Services Administration, be-
cause they say it much better than I can. 
 
Your home computer is a popular target for intruders. 
Why? Because intruders want what you have stored 
there. They look for credit card numbers, bank account 
information, and anything else they can find. By stealing 
that information, intruders can use your money to buy 
themselves goods and services. But it‘s not just money-
related information they‘re after. Intruders also want your 
computer‘s resources, meaning your hard disk space, 
your fast processor, and your Internet connection. These 
are called TROJANS and WORMS. They use these re-
sources to attack other computers on the Internet. In 
fact, the more computers an intruder uses, the harder it 
is for law enforcement to figure out where the attack is 
really coming from.  
 
How do intruders break into your computer? In some 
cases, they send you email with a virus. In other cases, 
they take advantage of a flaw or weakness in one of 
your computer‘s programs – a vulnerability – to gain ac-
cess. Once they‘re on your computer, they often install 
new programs that let them continue to use your com-
puter – even after you plug the holes they used to get 
onto your computer in the first place. These ‗backdoors‘ 
are usually cleverly disguised so that they blend in with 
the other programs running on your computer.  Following 
are things you should do to protect your computer: 
 
· Task 1 - Install an Anti-Virus Program  
These programs look at the contents of each file, 
searching for specific patterns that match a profile – 
called a virus signature – of a program known to be 
harmful. 
 
For each file that matches a signature, the anti-virus pro-
gram typically provides several options on how to re-
spond, such as removing the offending patterns or de-
stroying the file. 
 
Viruses can reach your computer in many ways, through 
floppy disks (flash drive), CD-ROMs, DVDs, email, web 
sites, and downloaded files. There are many thousands 
of new viruses created each day! Never go on the Inter-
net without active anti-virus protection.   
 

· Task 2 - Keep Your System Patched  
Patches, or small modifications of programs are often 
supplied by the software vendors. These close security 
‗holes‘ in the programs that would allow illegal entry into 
your computer. Microsoft and Adobe offer frequent 
patches which should be installed when provided.  
 
· Task 3 - Use Care When Reading Email with At-
tachments 
Do not open attachments that you are not sure about. 
Do not respond to emails by clicking on a LINK, which is 
a blue underlined word or phrase. Identify and remove 
SPAM (unwanted emails). Many programs are available 
to accomplish this. Be aware of PHISHING whereby an 
email tricks you into providing confidential information 
by impersonating a valid website. These become more 
sophisticated each day.  
 
· Task 4 - Install and Use a Firewall Program  
On a computer, the firewall acts much like a guard when 
it looks at network traffic destined for or received from 
another computer. The firewall determines if that traffic 
should continue on to its destination or be stopped. The 
firewall ‗guard‘ is important because it also keeps the 
unwanted out and permits only appropriate traffic to en-
ter and leave the computer.  
 
· Task 5 - Use Strong Passwords  
Passwords should contain both letters, numbers and/or 
symbols and should be at least 5 characters long. Use 
an encrypted password keeper program so you don‘t 
forget them. 
 
There are programs which will automatically insert your 
user name and password when requested.  
 
· Task 6 - Install and Use a Hardware Firewall  
Complement your firewall program by installing a hard-
ware firewall. Together, these two firewalls stand be-
tween your home computer and the Internet. A 
ROUTER acts as a hardware firewall.  
 
· Task 7 - Install and Use a File Encryption Program 
Consider encrypting sensitive files such as your finan-
cial data and passwords. Many encryption programs are 
available and some are free. 
 
In summary, take computer security seriously – many 
thousand skilled programmers are out there constantly 
seeking out your computer vulnerabilities. Don‘t be a 
victim.   
 
There is no restriction against any non-profit group us-

ing this article as long as it is kept in context with proper 
credit given the author. The Editorial Committee of the 

Association of Personal Computer User Groups 
(APCUG), an international organization of which this 

group is a member, brings this article to you. 

http://www.SCGsd.org
mailto:wilw@adnc.com


can be tricky to grasp initially. When you send an email, 
everyone will see the recipients in the To and Cc fields, 
but anyone in the Bcc field will remain hidden from all 
other recipients, even other recipients in the Bcc field. 
For example, if you want your recipients to remain un-
aware of the other recipients, include your own email 
address in the To field and put everyone else‘s email in 

the Bcc field.  
 
Encrypt Your Email  
Worried about those IT guys in your office being able to 
read your personal emails? Next time you are sending a 
private or personal email through Microsoft Outlook, 
encrypt it so only you and your recipient can read them. 
Head to the Tools menu, then click on Options and se-
lect the Security tab. Enter a password you‘ve shared 
with the recipient and no one who doesn‘t know the 
password will be able to open the message.  
 

Font Size On-The-Fly  
When you‘re working on a document, it can be tedious 
to constantly have to adjust font sizes manually. Or per-
haps you‘re working on a project with various types and 
sizes of fonts and need a way to quickly compare sizes. 
Whatever your needs, you can easily increase or de-
crease font sizes in Microsoft Office applications. High-
light the text and press CTRL-SHIFT-< to make the font 
smaller and CTRL-SHIFT-> to make the font larger.  
 

Word Add-In Templates  
Looking to automate a specific type of document func-
tion in Word, you may be able to download a template 
from the Internet. For instance, Microsoft provides thou-
sands of Word templates. With the perfect Word tem-
plate, you‘ll avoid wasting time designing and formatting 
a Word document to fit a particular style.  

 
Reprinted with permission from Smart Computing.  Visit 

http://www.smartcomputing.com to learn what Smart Comput-
ing can do for you and your user group! 

Try A New View  
In many instances, you'll only need to read a Word 
document without editing it or making any changes. 
Word's Reading Layout view presents word documents 
in a format that makes them far more palatable on the 
eyes; it also hides all toolbars except for the Reading 
Layout and Reviewing toolbars. To switch to reading 
layout, either click the Read button on Word's standard 
toolbar or open the View menu and click Reading Lay-
out. To exit reading layout, click the Close button in the 
Toolbar or open the View menu and click Normal.  
 

heap  
A term used by programmers to describe the amount of 
memory a program needs in order for it to work. Heap 
memory has been set aside for a program to request as 
needed to operate. A set amount of heap memory is 
hard to determine before a program is started because 
the amount changes as a program runs.  

 
We Favor Phones  
According to Rebtel, U.S. adults still favor phone calls 
when talking to work colleagues. When talking shop, 
43% of our communications occur via voice and phone 
calls, 33% by email, 12% by text and SMS messages, 
and 6% by social networks.  
 

The Durham Museum  
The Durham Museum is exhibiting Pulitzer Prize-
winning photos and has a popular train station exhibit. 
Stop by in person or enjoy the museum‘s online content.  
http://www.durhammuseum.org  
 
Carbon Copy Control  
Understanding who‘s privy to the list of recipients to one 
of your emails can help you avoid a potentially embar-
rassing interoffice gaffe. Knowing Cc stands for carbon 
copy and Bcc stands for blind carbon copy is fairly re-
medial computing knowledge, but the blind carbon copy 

 

      Association of Personal  
       Computer User Groups 

MEMBERSHIP WITH LCCUG: 
 Yearly dues are $25 .  For more information, contact: 

 

Director of Membership, 

membership@lccug.com. 

 

Directions to Meetings: 
A map and directions to our meetings can be found on our 

Members’ web page www.lccug.com/members.  Just click 

on the link “Meeting Locations & Directions” 
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